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Toolkit Support 
If you encounter a problem with Toolkit 2004, contact either the Help Desk or Toolkit 
Support for assistance (see the table below for contact information).  Help desk support is 
available weekdays from 6 AM to 6 PM Mountain Standard Time.   

Toolkit 2004 Technical Support Information 

Help Desk  

Phone 888-311-1444 

Web Site https://merlin.sc.egov.usda.gov/magicsshd/ 
Toolkit Support  

Email toolkitsupport@itc.nrcs.usda.gov 

Document the Problem 
You can assist the support team in resolving the problem expediently by gathering some 
basic information about the issue you encounter. 

First, document the steps or actions you performed just prior to the error.  Second, when 
possible:   

 Capture the error or warning message by simultaneously pressing the Ctrl and 
Print Screen buttons on the keyboard (to copy the message), then paste the 
screen shot into a blank MS Word document and save the document (if a support 
person is not readily available).   Once saved, you can either show the document 
to your onsite support specialist, or email the document to Toolkit Support, along 
with any other relevant information. 

 If possible, leave the message visible until the support person can see it (if a 
support specialist is readily available at your site, or if a net meeting is 
scheduled). 

Third, inform the technical support specialist which version of Toolkit 2004 you are using.  
(See the Toolkit 2004 FAQ page at http://www.itc.nrcs.usda.gov/toolkitng/faq_main.htm 
for instructions on determining which version of Toolkit is installed on your workstation). 

Toolkit 2004 Web Site 
For more information on Toolkit 2004, see the Toolkit 2004 Web site at: 
http://www.itc.nrcs.usda.gov/toolkitng/toolkit2004.   

 



Scope 
This document, aimed at Toolkit 2004 users, provides information on features and functions 
included in the Toolkit ArcGIS Extension.  ArcGIS topics covered in this user guide include:  
basics, symbology, common functionality among toolbars, legacy shapefiles, data frames and 
layers, map labels tool, buffering tool, digitizing tool, attribute tool, map products tool, soils 
map/inventory tool, and total acres tool. 
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Overview 
Toolkit Tools  
The Toolkit toolbar has the following buttons that are called tools.  

 

ArcGIS Tools Icon Purpose 

Zoom to Plan 
 

• Zooms to the extent of the customer's planned 
land units. 

Select a Plan 
 

• Adds the customer’s plan layers, including planned 
land units and practice layers, to the view.  

Import Legacy 
Shapefiles  

• Allows users to import existing land unit shapefiles 
into the Toolkit 2004 geodatabase. 

Total Acres  • Calculates the acres of one or more polygons such 
as fields, ponds or easements. 

• Provides the total length of the perimeters.  

• Calculates lengths for line features such as fence 
or pipelines and give a total count for the number 
of features selected for any layer type (point, line 
or polygon). 

Map Products 
 

• Creates a map with a heading, a legend, a scale bar, 
and a north arrow. 

Map Labels  • Allows user to create labels for all vector layers.  

Soils 
Map/Inventory  

• Creates a soils map for a customer's land units and 
provides a soils inventory report for the selected 
area.  

Buffer 

 
 

• Draws a polygon of a specified width either inside 
or outside of an area or around a point or line.   

• Allows buffers to be created on one side of a line. 

Attribute Tool 
 

• Inputs information about various layers into the 
corresponding table including Land Units, Practice 
Layers and Resource Inventory layers. 

New Toolkit 
Layer  

• Creates new layers including Planned Land Units, 
Practice and Resource Inventory Layers. 

• Builds new layers and adds them to the view.  

Toolkit Digitizer 
 

• Allows a user to add or edit features for any type 
of layer. 
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Digitizing Off 
 

• Indicates that the digitizing (i.e., Edit Mode) is 
off. 

Digitizing On 
 

• Indicates that the digitizing is in Edit Mode.  

Note:  To access and use the Toolkit extension tools, see Start Up Toolkit Extension 
(ArcGIS). 

 
ArcGIS Interface 
The Toolkit ArcGIS interface consists of a table of contents that contain the layers that 
may be displayed in the View.  A menu bar and toolbars comprise the graphical user 
interface.  Several pop-up menus are available using a right-mouse click. 

 

 
 

 
ArcGIS Project 
ArcGIS Projects (Map Documents) may contain Multiple Views (Data Frames); however, an 
ArcGIS project may only have one Layout.  The Layout is always live-linked to the View. 
 ArcGIS project files can be recognized by their .mxd file extension. 
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Spatial Data for Use with ArcGIS 
ArcGIS Toolkit users may access spatial datasets (e.g., image files and soils data) from the 
server (located under F:\geodata as outlined in the Geospatial Datasets Filenaming 
Standard) or the local C: drive.  

Note:  Contact your state GIS specialist for additional information on the Geospatial 
Datasets Filenaming Standard. 

 
Change ArcView Projects to ArcGIS Map Documents 
ArcView projects developed for customers in Toolkit 4.x are not compatible with Toolkit 
2004; therefore, you may want to export these layouts as graphic files that can be stored 
in the customer file as historical documents. There are two tools available to help with this 
process: 

• Toolkit APR Utility 

• Export Layout Utility 

Prepare ArcView Projects for Exporting 
The APR Utility automatically remaps paths for customer data from C:\Customer_Files to 
C:\Customer_Files_Toolkit.  The utility also removes the dependency on the Toolkit Core 
Extension, Soil Data Viewer Extension, and the Wetland Easement Extension in the project 
files.  It is highly recommended that you run the APR utility before exporting layouts that 
were developed in earlier versions of Toolkit.  

Note:  The APR utility can be run in batch mode on all customer files stored on the server 
(for specifics see the Toolkit Utilities). 
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Export Layouts from Existing ArcView Projects 
Layouts for existing ArcView projects may be exported as graphic files in one of two ways.   

• Export layouts from existing ArcView projects using the Export Layout Utility 

• Export layouts using standard ArcView 3.x functionality 

Use the Layout Export Utility to export layouts from existing ArcView projects. The utility 
exports all layouts in a project, saves them as graphic files, and stores them in the customer 
file under the Resource_Maps subfolder.  

Running this utility in batch mode is not recommended rather use the utility to export 
layouts on an as needed basis (see Use the Export Layout Utility). 

Export Layouts with ArcView 3.x Functionality 
Layouts can be exported using standard ArcView 3.x functionality. Even after running the 
APR Utility, you may get several Where Is questions when opening ArcView because of 
dependencies on other extensions or data sets that are no longer available. You may redirect 
ArcView to find the missing data or click Cancel All to bypass the questions and open the 
project with data that is still available. Once you have opened the ArcView project:.  

1. Minimize the View Window. 

2. From the Project Window, click on the Layouts icon to display all layout names. 

3. Open the layout you wish to export. 

4. From the File menu, select Export Layout.  

5. Browse to the customer’s Resource_Maps subfolder. 

6. Enter a name for the graphic file. 

7. Click OK. 

8. Repeat the process for each layout you wish to export. 
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Compare ArcView and ArcGIS Terms 
The table below compares some of the common terminology used in ArcView 3.3 and 
ArcGIS 8.3. 

 

ArcView 3.3  ArcGIS 8.3 

Project Map document 

Theme Layer 

View Data frame 

Projection Coordinate system 

Hotlink Hyperlink 

Charts Graphs 

Avenue scripts Visual Basic for Applications 
(VBA) macros 

Active theme Selectable layers 

AVL (legend file) Import symbology from layer 
file 

Symbol window Symbol Selector 

Symbol files (.avp files) Styles 

Promote Selected Open Table for Selected 

Database theme Geodatabase layer 

Image theme Raster layer 

Image catalog Raster catalog 

Feature theme Feature layer 

Convert to Shapefile Data > Export 

Add theme Add data layer 
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ArcGIS Basics 

Data Frame and Layer 
Create a Data Frame 
To create a new data frame (View), complete the following steps. 

1. From the menu bar, select File. 

 
2. Select New Data Frame.   

• The new data frame opens and is displayed in the table of contents.  

 
Rename the Data Frame 
To rename a data frame (View), complete the following steps. 

1. From the table of contents, right-click on the title "Layers." 

2. Select Properties. 

• The Data Frame Properties dialog is displayed. 
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3. From the General tab, enter a new name for the data frame. 

• The new name is displayed in the table of contents. 

4. Click OK. 

 
Set Data Frame Properties 
To set data frame properties, complete the following steps. 

1. From the table of contents, right-click Layers. 

2. Select Properties. 

• The Data Frame Properties dialog is displayed. 
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• From the General tab, the Map unit for the data frame is automatically set to 

meters (i.e., the default for UTM NAD 83 data).   

• ArcGIS sets the map units based on the projection of the first data layer added to 
the data frame. 

3. For the Display unit, select the unit that you wish to work with (generally this is set 
to feet).  

4. Click OK. 

 
Add a Layer to the Data Frame 
To add a layer to a data frame (View), complete the following steps. 

1. Click the Add Data icon  on the tool bar.  

• The Add Data dialog is displayed. 
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2. Browse to the location of the file that you wish to add. 

• If the directory you need is not available, see Connect to Folder. 

3. Select the layer you wish to add to the data frame. 

4. Click Add.  

Note:  You may select multiple layers by holding down the shift key and making your 
selections at the same time. 

 
Connect to a Folder 
To connect to a folder, complete the following steps. 

1. Click the Add Data icon  on the tool bar.  

• The Add Data dialog is displayed. 

Note:  The directories listed in the Look in dialog box are displayed from ArcCatalog, 
not from Windows Explorer.  
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2. If the directory you need is not listed, click on the Connect to Folder icon . 

3. Browse to the directory that you wish to add to the ArcCatalog directory list.   

4. Highlight the directory. 

5. Click OK.   

• The new directory is now available in the Look in dialog box (i.e., 
ArcCatalog). 

 
Basic Layer Operations 
Several basic display and query operations can be performed on layers. 

• Identifying:  displays the attributes of a feature.  

• Selecting features from a layer:  selects a feature by clicking on it. To 
selects several features, draw a rectangular area around the area of interest or 
hold down the shift key when selecting the individual features. 

• Measuring distance:  reports the accumulated distance between two or more 
points and temporarily displays them  in the status bar.  

• Panning:  repositions the display without changing the size.  

• Zooming:  changes the size and extent of the map display in the View and 
changes the scale of the display.  In addition, you can zoom to layer.  
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Table of Contents 

1. To turn a layer off, click to remove the check mark in the box.  

2. To turn a layer on, click inside the check box to display the check mark.  

 
3. To collapse the table of contents, click the minus sign (-) in the box.  

4. To expand the legends in the table of contents, click the plus sign (+)in the box. 

5. To change the order of a layer, click and hold the mouse over the layer name and 
drag the layer to the desired position.  

• ArcGIS draws themes sequentially starting with the layer at the bottom of 
the table of contents.  

Note:  For ease of viewing the table of contents, it is best to keep the base layer closed 
and turned off, which will hide the underlying layers used by the Toolkit personal 
geodatabase.  

 
Rename a Layer 
To rename a layer, complete the following steps. 

1. Right-click on the layer name in the table of contents. 
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2. Select Properties. 

• The Layers Properties dialog is displayed. 

 
3. From the General tab, enter the new Layer Name.   

4. Click OK.  
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• The new name is displayed in the table of contents (also legends created for 
layouts). 

• The original directory path and filename are shown under the source tab in 
the Layer Properties dialog. 

Note:  Changing the Layer Name does not change the data source file name (display 
purpose only).   

 
Pan 
Use the Pan tool to change the focus of the view.  To turn on the Pan tool, click on the Pan 

tool icon  on the ArcGIS toolbar.  Then: 

1. Click and hold down the mouse while dragging the map. 

2. Move the map as needed. 

3. Release the mouse button when the map is in the desired location. 

 
Zoom to Layer 
Since there are no active themes in ArcGIS, there is no zoom to active theme button.  In 
order to zoom to a particular layer, complete the following steps. 

1. Right-click on the layer name in the table of contents. 

 
2. Select Zoom to Layer from the menu options. 

Note:  Zoom to Layer replaces ArcView’s Zoom to Active Theme. 

 
Open a Layer’s Attribute Table 
To view a layer's attribute table, complete the following steps. 
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1. From the table of contents, right-click on the name of the layer. 

 
2. Select Open Attribute Table.  

 
Remove a Layer 
To remove a layer, complete the following steps. 

1. From the table of contents, right-click on the name of the layer. 

 
2. Click Remove. 

 

Symbology 
Change Symbology 
ArcGIS offers numerous options for creating symbology.  Some of the more commonly used 
options include:  

• Add Single Symbol Legends 
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• Set up Legends using Unique Values 

• Save Symbology 

• Create Layer Files 

 
Add Single Symbol Legend 
To add a single Symbol Legend, complete the following steps. 

1. From the table of contents, right-click on the layer. 

 
2. Select Properties. 

• The Layers Properties dialog is displayed. 

3. Select the Symbology tab. 

4. In the Show area, select Features and Single symbol.  

 
5. Click OK. 

6. Double-click on the colored box in the Symbol area.  

• The Symbol Selector is displayed. 

7. Select Category from the drop-down list.  

8. As needed, change the properties.  
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• Fill Color 

• Outline Width 

• Outline Color 

• Properties 

• More Symbols 

9. Click Save. 

10. Click OK.  

 
Set Up Legends Using Unique Values 
To add a legend using unique values, complete the following steps. 

1. From the table of contents, right-click on the layer. 

2. Select Properties. 

• The Layers Properties dialog is displayed. 

3. Select the Symbology tab. 

4. In the Show area, select Categories and Unique Values for the legend type.  

 
5. In the Value Field area, select the attribute from the drop-down list for sorting. 
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6. Double-click symbol box (i.e., a color box) to highlight the row. 

7. As needed, Add Values or Remove values. 

8. Click Apply. 

9. Click OK. 

 
Map Symbols and Legend 
Since the map symbols provided by ArcGIS are not well-suited to conservation planning, 
three sets of map symbols are provided with the Toolkit:  

• Conservation planning symbols 

• SSURGO soil symbols 

• Ad-hoc SSURGO symbols 

 

To load the Toolkit Map Symbols, choose More Symbols from the Symbology Tab , and 
place a check in front of the NRCS planning symbols, or SSURGO symbols.  Click OK.  The 
symbols will be added to the bottom of the symbol palette. 

For specifics, see the "Map Symbols" section of the Toolkit ArcGIS Appendix. 

 
Save Symbology 
To save a legend for the current map document, complete the following steps.  

1. From the table of contents, right-click on the layer. 

2. Select Save Symbology. 

 
Create Layer Files 
Layer Files may be created as a way to store default legends for a layer.  Layer files store 
the original dataset’s location, the default legend, and layer name as a single file.  Once 
layer files have been created they can be added as a layer (in place of the original dataset) 
in the map document.  To create a new layer file, complete the following steps. 

1. From the table of contents, right-click on the layer. 

2. Select Save as Layer File. 

3. Select the directory from the drop-down list for the new layer file. 

4. Enter a name for the layer file. 
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5. Click Save. 

 
Label Single Features 
Toolkit provides a map labels tool for auto-labeling features.  In order to add single labels 
to a map, use the standard ArcGIS label tool.  To set the label properties, complete the 
following steps. 

1. From the table of contents, right-click on the layer you wish to label. 

2. Select Properties. 

• The Layers Properties dialog is displayed. 

3. Select the Labels tab. 
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4. Select the desired Label Field from the drop-down list for labeling features. 

 

Once you have set the label properties, complete the following steps to add a label to a 
single feature in the View. 

1. From the table of contents, select the layer you wish to label. 
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2. Click on the Text Tool on the Drawing Toolbar.  Several label choices will be 

displayed.  Select a Label style from the drop-down list on the Drawing toolbar. 

• The Labeling Options dialog is displayed. 

3. Select Place label at position clicked. 

4. Click on View in the location where you wish to place the label. 

 
Edit Label 
To edit a label, complete the following steps. 

1. Use the Select tool  on the Drawing Toolbar to select a single label to edit. 
 Select multiple labels by holding down the Shift key when making your selection, or 
to select all labels, from the Edit menu, choose Select All Elements. 
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2. Once the labels are selected, use the Drawing toolbar to modify font style, size, 
color, etc. 

 

 
 
Edit Text in a Label 
To edit text in a label, complete the following steps. 

1. From the table of contents, select the layer. 
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2. Use the Select Tool from the Drawing Toolbar. 

3. Double-click the label you wish to edit. 

4. As needed, edit the label in Text area. 

5. Click OK. 

 

Query Builder 
Use the Query Builder 

1. From the table of contents, right-click on the layer name.  

2. Select Properties. 

• The Layers Properties dialog is displayed. 

3. Select the Definition Query tab. 
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4. As needed, select the Fields to be used in the query.  

5. As needed, select the operator (e.g., =, >, -). 

6. As needed, select the Unique sample value. 

7. Click OK. 

 

Toolkit Toolbar 

Basics 
Operate the Toolbar 

 
The Toolkit toolbar contains 12 customized tools. If the Toolkit toolbar is not displayed 
when ArcGIS project is opened, click the NRCS icon at the top of the ArcGIS toolbar.  

Change the Shape of the Toolbar 
Change the shape of the toolbar by moving the mouse over a corner or edge until a handle 
cursor appears. Hold down the left mouse key and drag the box to reshape it.  

• Change the toolbar to a long vertical bar by dragging it to the side of the screen. 
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• Change the toolbar to a long horizontal bar by dragging it to the upper or lower 
part of the screen.   

Move the Toolbar 
To move the toolbar, place the cursor on the blue title bar.   

• Hold down the left mouse button while dragging the toolbar to another location.   

• Release the mouse button to drop the toolbar in the new location. 

• The Toolbar can be docked anywhere on the ArcGIS interface by dragging and 
dropping it in the desired location. 

Display the Name of a Tool 
To display the name of a tool, hold the cursor over an icon, and a tool tip is displayed. If 
needed, click once in a gray area of the toolbar to activate the tool tips. Some tools are 
always available, while other tools are available only when specific criteria are met (e.g., the 
Soils Inventory/Report tool is active only when a Soils layer is available). 

• Active buttons are brightly colored. 

• Inactive buttons are grayed.  

 

 
Zoom to Plan 
To zoom in on the planned land units, complete the following steps. 

1. Click on the Zoom to Plan icon . 

2. The view will automatically adjust to accommodate the planned land units layer. 
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Select a Plan 
Use the Select a Plan tool to select and add a customer’s planned land units and practice 
layers that were checked out from the NCPDB to the View. 

1. Click on the Select a Plan icon . 

• The Select a Plan dialog is displayed. 

 
2. Select a plan layer from the Select a Plan drop-down list.   

3. If you do not wish to add existing practices, check the Do not add practices check 
box. 

4. Click OK. 

5. The Plan Layer will be added to the View. 
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Note:  If no spatial features are available, only tabular data will be included in the layer. 
Add spatial features by importing an existing shapefile, or by creating a new planned land 
units layer and linking the features to the existing tabular records. 

 

Total Acres Tool 
Total Acres 

Use the Total Acres tool  on the Toolkit toolbar to display the total acres, perimeter 
and count of selected polygons, the total length and count of lines or the total count of 
points.  

• Use Total Acres on Point Layers 

• Use Total Acres on Line Layers 

• Use Total Acres on Polygon Layers 

 
Use Total Acres on Point Layers 

1. Click the Total Acres tool  

• The Total Acres dialog is displayed. 

• The Total Acres dialog box displays. 

2. Select the layer you wish to analyze. 

 

3. Click Select Feature to select one or more points.  

• To select multiple features, hold down the Shift key as you select. 

• The total number of features selected is displayed in the Count box. 
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Use Total Acres on Line Layers 

1. Click the Total Acres tool . 

• The Total Acres dialog box displays. 

2. Select the layer you wish to analyze. 

 

3. Click Select Feature to select one or more lines.  

• To select multiple features, hold down the Shift key as you select. 

• The total length of the selected feature(s) is displayed in the Length box. 

• The total number of features selected is displayed in the Count box. 

• Values displayed may be copied and pasted elsewhere, but the value may not 
be edited.  

4. To copy the value, double-click inside the box to highlight it.  

5. Click the right mouse key and select Copy.  

6. Paste the value in another location (e.g., a Word document). 

 
Use Total Acres on Polygon Layers 

1. Click the Total Acres tool .  

• The Total Acres dialog box displays. 

2. Select the layer you wish to analyze. 
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3. Click Select Feature to select one or more polygons.  

• To select multiple features, hold down the Shift key as you select. 

• The sum of calculated acres for the selected feature(s) is displayed in the 
Area box.   

Note:  If features overlap, the total acres calculated may be more than the selected 
area. 

• The sum of the perimeter(s) of the selected feature(s) is displayed in the 
Perimeter box. 

• The total number of features selected is displayed in the Count box. 

4. If the polygon layer contains land units, select the Program option to view the sum 
of the acres entered in the Acres box on the Land Unit dialog box.  

• Values displayed may be copied and pasted elsewhere, but the value may not 
be edited.  

5. To copy the value, double-click inside the box to highlight it.  

6. Click the right mouse key and select Copy.  

7. Paste the value in another location (e.g., the Approximate Acres box on the Map 
Products dialog box or a Word® document). 

 

Legacy Shapefiles 
Import Legacy Shapefiles 

Import Legacy Shapefiles  allows you to import planned land unit that were created in 
earlier versions of Toolkit into the Toolkit 2004 Geodatabase.  Imported Planned Land Units 
can be linked to the existing tabular data in the NCPDB. 

• Import Planned Land Unit Shapefiles 
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• Import Practice Shapefiles 

 
Import PLU Shapefiles 
To import an existing PLU shapefile, complete the following steps. 

1. Click the Import Legacy Shapefile icon . 

 
 

2. Click on the Browse to locate the shapefile you want to import. 

 
• The default location for Toolkit 4.x shapefiles is the Customer’s Plan 

Maps\Plan folder. 

3. Highlight the shapefile you wish to import and click Select. 

• The selected shapefile is displayed in the dialog box. 
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• When importing a shapefile that has practices but no matched land units in 
the consplan, it may take longer to import. 

4. Click OK. 

• A Legacy Spatial Import Report displays matches found between the 
imported features and tabular data found in the NCPDB.  

Note:  This dialog box is for informational purposes only.  No edits/changes may be 
made using this screen.  

5. Review the Legacy Spatial Import Report. 

 
• The Shapefile Data displays all polygons (fields) that were included in the 

shapefiles. If there are any unchecked shapefiles in the left window, these 
need to be attributed using the Attribute Tool (see Enter Data for PLUs).   

• The Consplan Data displays all tabular records found in the NCPDB. If there 
are any unchecked land units in the right window, these will need to have 
fields digitized and linked to the attribute information (see Use the 
Digitizing Tool). 

6. When finished reviewing the report, Click OK to close the  window. 

• Imported features are displayed in the view. 

• Once a shapefile has been imported, the filename is modified to include a 
.bak extension (e.g. consplan.shp becomes consplan.shp.bak). This prevents 
the shapefile from being available for subsequent imports. 

 
Import Practice Shapefiles 
Practice shapefiles are imported through the New Toolkit Layer option.  For instructions, 
see Create a Practice Layer. 
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New Toolkit Layer 
New Toolkit Layer 

Use the New Toolkit Layer tool  to add predefined resource planning layers to a view. 
 Use the New Layer tool to create these layers: 

• Planned Land Units 

• Practices 

• Resource Inventory  

• Build Your Own 

Planned Land Units 
Use the New Layer tool to create Planned, Alternative, or Benchmark land units for a 
customer for conservation planning.   

• You may copy land units from a DLU or CLU layer or digitize them manually.  

• Use Benchmark Land Units to retain the existing field boundaries as a separate 
layer.  

• Use Alternative Land Units to display a variety of field boundary configurations 
(each on a separate layer). 

Note:  The terms Planned, Alternative, and Benchmark are used only to describe land units. 
Toolkit never requires you to document conservation systems.  In addition, layers created 
using this tool are automatically associated with a dialog box and an attribute table.  

Practices 
Use the New Layer tool to create a point, line, or polygon layer to locate planned or applied 
structural practices (e.g.,  wells, irrigation pipelines, or troughs). 

Resource Inventory 
Use the New layer tool to create a point, line, or polygon layer to locate soil samples, 
existing pipelines, or problem areas. 

Build Your Own 
Use the New Layer tool to create a point, line, or polygon layer and to define your own 
attributes.  

This feature works in the same way as the ArcGIS New Layer tool.  For specifics, see the 
following topics. 

• Create a PLU Layer without a CLU Layer 
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• Create a PLU Layer from CLU Layer 

• Create a Practice Layer 

• Create a Resource Inventory Layer 

• Build Your Own Layer 

• Create Tract Boundary Layer 

 
Create a PLU Layer without a CLU Layer 
These instructions are for offices that do not have access to a DLU or CLU layer.  To 
digitize a PLU layer, complete the following steps.  

1. Open a customer’s ArcGIS project (.mxd file). 

2. Load County Ortho Photography. 

3. If no plan database (i.e., unmapped land units) exists, proceed to step 5.   

• If an unmapped land units exist in a plan database, click on Cyber Farmer 
and select plan database to load.  

• The message "No shapes were found. Planning Land Units can be imported 
into Toolkit utilizing Import Legacy tool" is displayed. 

4. Click OK.  

• If planned land units shapefiles are available for importing, see Import 
Legacy Shapefiles. 

• If no planned land units are available, continue with step 5. 

5. Click on the New Toolkit Layer tool . 

• The New Toolkit Layer dialog box is displayed. 
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6. Under Digitized Land Units, select one of the following: 

• Planned Land Units 

• Benchmark Land Units 

• Alternative Land Units 

7. Under Create Plan, select one of the following: 

• Create a new plan database with new land unit layer (select this option if 
no land unit database exists in the NCPDB). 

• Link to existing plan database (select this option if unmapped planned land 
units exist, but no spatial data has been created for the land units), proceed 
to step 11. 

8. If you select to Create a new plan database with new land unit layer, accept or 
change the Layer Name, and then click OK.  

• The message"Use features from a source Layer" is displayed. 

9. Click No.  

• The new layer is added to the view and available for digitizing  (see Digitize 
Land Units). 
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10. Once land units have been digitized, use the Attribute tool to link the new features 
to the unmapped land unit records in the database (see Attribute Planned Land 
Units). 

• If you select to Link to an existing plan database, the dialog box is 
updated to allow you to select the plan database you want to link to.   

11. Select the existing database from the Existing Plan drop-down list. 

12. Click OK.  

• The layer is added to the view in Edit mode and available for digitizing. (see 
Digitize Land Units) 

13. Once land units have been digitized, use the Attribute Tool to link the new features 
to the unmapped land unit records in the database (see Link Features with the 
Attribute Tool). 

 
Create PLU Layer from CLU Layer 
The following instructions are for offices that have a DLU layer or have access to a  CLU 
layer from FSA. 

1. Open a customer’s ArcGIS project (.mxd file). 

2. Load County Ortho Photography. 

3. If planned land units shapefiles are available for importing, see Import Legacy 
Shapefiles. 

4. If no planned land units shapefiles are available for importing, proceed to step 5. 

5. Click the New Toolkit Layer icon   

• The New Toolkit Layer dialog box is displayed.  
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6. Under Digitized Land Units, select one of the following: 

• Planned Land Units 

• Benchmark Land Units 

• Alternative Land Units 

7. Under Create Plan, select one of the following: 

• If no land unit database exists in the NCPDB, select Create a new plan 
database with new land unit layer.  Proceed to step 8.  

• If existing unmapped land units are available and you wish to create spatial 
data and link to the existing tabular records, select Link to existing plan 
database.  Proceed to step 18. 

8. If you select Create a new plan database with new land unit layer, accept or 
change the Layer Name, and then click OK.  

• The message "Use features from a source layer?" is displayed. 

9. Click Yes.  

• The Create a New Layer dialog window is displayed. 
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10. Select the Source Layer that contains the CLU (or DLU) features. 

11. Select a  Source Layer Options. 

12. If you select Query By:, select either Tract Number or Farm Number from the 
drop-down list.  

• Highlight the tract or farm number(s) in the drop-down list.  You may select 
more than one number by holding down the Shift key as you make your 
selections. 

• When you are finished with your selection, click OK.  Proceed to step 14. 

13. In order to use the Use Selected Features option (grayed out in the above graphic), 
you must have selected land units in the source layer either with the select feature 
tool or through a query before beginning the Create a New Layer process.   

• Use the Select Feature tool to select features on the source layer prior to 
beginning the Create New Layer process. 

• Click OK. 

14. The new layer is added to the view and available ready for digitizing (see Digitize 
Land Units). 

15. Edit the new planned land units layer as necessary.  When finished, choose Stop 
Editing from the Editor button. 

16. When prompted, click Save. 

17. Once land units have been created, use the Attribute tool to attribute the new 
features to the unmapped land unit records in the database (see Attribute Planned 
Land Units). 



Toolkit ArcGIS Extension   February 17, 2005 

37 

18. When making selection on the New Toolkit Layer dialog window, if you choose to Link 
to an existing plan database, the dialog box is updated to allow you to select the 
plan database you want to link to.   

19. Select the existing database from the Existing Plan drop-down list. 

20. Click OK. 

• The layer is added to the view in Edit mode ready for digitizing (see Digitize 
Land Units). 

21. Once land units have been digitized, use the Attribute tool to link the new features 
to the unmapped land unit records in the database (see Link Features with the 
Attribute Tool). 

 
Create a Practice Layer 
Besides the Planned Land Unit layers, the NCPDB includes three practice layers.  All 
practice layers created for customers must be incorporated into these three layers. 

• Practice Points 

• Practice Lines 

• Practice Polygons 

To create a new practice layer for a customer, complete the following steps. 

1. Open a customer ArcGIS project (.mxd file). 

2. Load the customer’s plan database using the Select a Plan tool. 

3. Load ortho photography. 

4. Click on the New Layer icon . 

• The New Toolkit Layer dialog window is displayed. 
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5. Select the type of Practice layer you want to create.   

• Point 

• Line 

• Polygon 

6. Choose an option to Create Practice  

• If you select Create new practice layer, the Layer Name is set by default.  

• If you select Import existing practice shapefiles into new practice layer, 
see Import Legacy Shapefiles.  

7. Click OK. 

8. The practice layer is added to the View, ready for editing (see Digitize Practice 
Layers). 

 
Create a Resource Inventory Layer 
Toolkit 2004 creates the resource inventory layers as shapefiles, and stores them in the 
customer files Plan Maps\Plan directory.  Resource Inventory layers are not checked in to 
the NCPDB.  All resource inventory shapefiles are created in the same manner as they were 
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created in Toolkit 4.1.  To create a new resource inventory shapefile, complete the following 
steps. 

1. Open a customer ArcGIS project (.mxd file). 

2. Load the customer’s plan database using the Select a Plan tool. 

3. Load ortho photography. 

4. Click on the New Layer icon . 

• The New Toolkit Layer dialog window is displayed. 

 
5. Under Resource Inventory, select the type of layer to be created.  

• Point 

• Line 

• Polygon 

6. Accept or change the Layer Name.  

7. Accept File Name or click the Browse button to change it. 

8. Click OK.  
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• The new layer is added to the view and available for editing.   

9. Edit the layer as needed (see Digitize Resource Inventory Layers). 

10. When finished, choose Stop Editing from the Editor button.   

11. When prompted, click Yes to save your changes. 

12. To attribute the layer, use the Attribute Tool (see Attribute Resource Inventory 
Layers). 

 
Build Your Own Layer 
With Toolkit you can create additional shapefiles, also referred to as Build Your Own 
layers. The layers are created as shapefiles and stored in the customer files Plan Maps\Plan 
directory, they are not checked in to the NCPDB.  

Note:  Build Your Own shapefiles are created in the same manner as they were in Toolkit 
4.1. 

To create a Build Your Own shapefile: 

1. Open a customer ArcGIS project (.mxd file). 

2. Load ortho photography or other reference layer. 

3. Click on the New Layer icon  on the Toolkit Toolbar. 

• The New Toolkit Layer dialog window is displayed. 
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4. Under Build Your Own, choose the type of layer to be created.  

• Point 

• Line 

• Polygon  

5. Accept or change the Layer Name.  

6. Accept File Name or click the Browse button to change it. 

7. Click OK.  

• The new layer is added to the view ready and available for editing.   

8. Edit the layer as needed (see Digitizer, Build Your Own Layers). 

9. When finished, choose Stop Editing from the Editor button.   

10. When prompted, click Yes to save your changes. 
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Digitizer 
Digitizer On/Off Indicator 
The Digitizer On/Off indicator is used to indicate whether or not the Digitizing Tools are 
active.   

• When no layers are in edit mode, the indicator appears as a grayed out circle . 
  

• When a layer is in edit mode, the indicator appears as a circle with a plus sign in 

the center .    

If the indicator shows that a layer is in edit mode but the digitizing toolbar is not 
displayed, click on the indicator to reopen the digitizing toolbar. 

 
Use the Digitizing Tool 
The Digitizing Tool is used to open a digitizing toolbar, which is used to add or edit features 
for any type of layer.   

1. To begin digitizing an existing layer, click on the Toolkit Digitizer icon . 

2. Select the layer you want to edit.   

• Depending on the type of layer you select, the appropriate digitizing toolbar will 
open.  

• In the case of creating a new theme, the digitizing toolbar is automatically be 
opened once the new layer is created. You will not have to click on the Digitizing 
Tool to open it. 

The section, Common Functionality on All Toolbars (below), describes the common tools 
available on each of the digitizing toolbars. 

 
Digitizing Shortcuts 
When using the Toolkit toolbars, the following digitizing shortcuts are available: 

Function Shortcut 

Pan Mode Hold down the C key and toggle to Pan Mode 

Zoom In Mode Hold down the Z key and toggle to Zoom In 
Mode 

Zoom Out Mode Hold down the X key and toggle to Zoom Out 
Mode 

Operation Mode Hold down the Ctrl key and then press the Z 
key 
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To activate the pan mode, you may also: 

• Select the Pan tool from the ArcGIS Toolbar while digitizing.  Once you have 
panned to the new location, click on the digitizing tool of choice and resume 
digitizing.   

• Use the scroll bars on the right side and lower edge of the View.  You will not need 
to reselect the appropriate digitizing tool when scrolling. 

 
Common Functionality on All Toolbars 
Several tools are common to all digitizing toolbars, regardless of the type of layer you are 
editing.  These common tools include the: 

• Editor - use to display a drop-down menu.  Choices include: 

• Start Editing - for turning on edit mode. 

• Stop Editing - for ending the edit session. 

• Save Edits - for saving edits periodically during the edit session. 

• Use vertical topology - use to ensure topology rules between layers.  If turned on, 
it prevents overlapping features between layers. If turned off, the topology rules 
are not enforced.  

• Snapping - used to set snapping parameters for the target layer. 

• Undo Edit - use to undo the last vertex or last completed feature. 

• Redo Edit - use to redo the last undo action. 

• Select Feature  - use to select features in the layer, prior to using other 
tools, such as split, merge or reshape. 

• Copy and Paste   - use to copy field boundaries from one layer and paste 
them into another planned land units layer. 

Land Unit Editor Digitizing Toolbar 

 
The Land Unit Editor includes a: 

•  Copy and Paste tool  - use to copy field boundaries from one layer and 
paste them into another planned land units layer. 
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• Add Field tool  - use to add fields, append fields and add inclusions to the 
planned land units layer. 

• Split Field tool  - use to split an existing field. 

• Merge tool  - use to merge two or more fields together. 

• Reshape tool  - use to reshape an existing field boundary. 

• Vertex Edit tool  - use to edit vertices of an existing polygon. 

Additional Digitizing Toolbars 
In addition, following digitizing toolbars are provided in Toolkit 2004: 

• Practice Layer Digitizing Toolbars 

• Resource Inventory Digitizing Toolbars 

• Build Your Own  Layers 

 
Practice Layer Digitizing Toolbars 

Practice Points 

 

• Point tool  - use to add practice points to the layer. 

Practice Lines 

 
The following tools are included in the Practices Lines Editor toolbar: 

• Add Line tool  - use to add practice lines to the layer. 

• Split Line tool  - use to split practice lines. 

• Merge tool  - use to merge two or more lines together. 

• Reshape tool  - use to reshape an existing line. 
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Practice Polygons 

 
The following tools are included in the Practices Polygons Editor toolbar: 

• Add Polygon tool  - use to add polygons, append polygons, and add inclusions to 
the practice polygon layer. 

• Split Polygon tool  - use to split an existing polygon. 

• Topology Edit tool  - use to select features before using the Reshape or 
Vertex tools. 

• Merge tool  - use to merge two or more polygons together. 

• Reshape tool  - use to reshape an existing polygon boundary. 

• Vertex Edit tool  - use to edit vertices of an existing polygon. 

 
Resource Inventory Digitizing Toolbars 

Resource Inventory Points  

 

• Point tool  - use to add resource inventory points to the layer. 

Resource Inventory Lines 
The following tools are included in the Resource Inventory Lines toolbar: 

• Add Line tool  - use to add lines to the layer. 

• Split Line tool  - use to split lines. 

• Merge tool  - use to merge two or more lines. 

• Reshape tool  - use to reshape an existing line. 

Resource Inventory Polygons 
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The following tools are included in the Resource Inventory Polygons toolbar: 

• Add Polygon tool  - use to add polygons, append polygons, and add inclusions to 
the resource inventory layer. 

• Split Polygon tool  - use to split an existing polygon. 

•  Merge tool  - use to merge two or more polygons together. 

• Reshape tool  - use to reshape an existing polygon boundary. 

• Circle tool  - use to add circles to the resource inventory layer. 

 
Build Your Own Layers 

Build Your Own Points 

 

• The Point tool  is used to add points to the layer. 

Build Your Own Lines 

 
The following tools are included in the Line Editor toolbar: 

• Add Line tool  - use to add lines to the layer. 

• Split Line tool  - use to split lines. 

• Merge tool  - use to merge two or more lines. 

• Reshape tool  - use to reshape an existing line. 

Build Your Own Polygons 

 
The following tools are included in the Line Editor toolbar: 

• Add Polygon tool  - use to add polygons, append polygons, and add inclusions to 
the layer. 
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• Split Polygon tool  - use to split an existing polygon. 

• Merge tool  - use to merge two or more polygons. 

• Reshape tool  - use to reshape an existing polygon boundary. 

• Circle tool  - use to add circles to the layer. 

 

Attributing Layers 
Attribute Tool 

Use the Attribute tool  on the Toolkit toolbar to enter or edit data about land units, 
practice layers or resource inventory layers.  

• Enter Data for Planned Land Units 

• Link Unmapped Land Units to New PLU Layer 

• Enter Data for Practices 

• Enter Data for Resource Inventory Layers 

 
Enter Data for Planned Land Units 

1. Click the Attribute icon  to display the Attribute Tool dialog box. 

2. Select the Planned Land Unit Layer you wish to attribute. 

• Once the Layer has been selected, the Attribute Tool dialog window displays the 
appropriate dialog boxes to complete the attribute record. 

3. Use the Select Feature icon  to select one field from the PLU layer to attribute. 

4. Complete the attribute information for the selected field.  

• Tract number is optional.  If the land unit was copied from a digitized land 
units theme, Tract number may appear in the Tract box.  Accept the value, 
change it or leave it blank. 

• Land Unit is required. Enter a field number. Field numbers may be numbers, 
letters or a combination of both (e.g., 1, 1a, 1A). 

• HEL is optional. Select a HEL determination from the drop-down list, or 
leave it blank. 

• Acres is required. Initially, Acres is defaulted to the Calcacres value. 
Accept the default, or type another value. Acres must be one-tenth (.1) or 
greater.  This value is used later in the Practice Schedule and Contract 
Wizard as the default amount when a practice or a component is measured in 
acres. 
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• Calcacres is the calculated acres of the digitized land unit.  It may not be 
changed. 

• NRCS Land Use is required.  Select a NRCS land use from the drop-down 
list. 

• Local Land Use is optional.  Select a Local land use from the drop-own list, 
or leave it blank. 

 
5. Once the attribute information has been completed for the selected land unit, click 

Apply. 

6. Click on the next field in the PLU layer to attribute. Continue the process of 
selecting fields, completing the attribute information and clicking Apply after each 
entry. 

7. When finished attributing all land units, click OK to exit the Attribute dialog box. 

 
Link Features with Attribute Tool 
The attribute tool may be used to link unmapped planned land units to new features created 
in Toolkit 2004/ArcGIS. Once the features have been digitized (see New Toolkit Layers), 
complete the following steps to link the features to the tabular records. 

1. Click on the Attribute Tool. 

2. Select the layer you want to work with. 
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3. Click the Link to Tabular button. 

• The attribute tool dialog box is expanded to include a section for linking the 
land unit features to the tabular records. 

 
4. Use the Select Feature tool to select a field in the View. 

• The feature information is displayed in the left window.   

5. Highlight the corresponding record in the right window. 

6. Click on the Link button to link the records. 

7. Click Apply. 

8. Select the next feature on the View.   

9. Repeat steps 4-8 until all features have been linked.  
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10. If there are additional features in the Planned Land Units layer that do not have 
corresponding tabular records, attribute these fields using the left hand side of the 
Attribute Tool dialog window (see Attribute Planned Land Units). 

• If there are additional records in the right window after all linking has been 
completed, these records will remain in the database as unmapped land units 
until the land units are digitized and linked.  

11. When finished, click OK to exit the Attribute Tool dialog box. 

 
Enter Data for Practices 

1. Click the Attribute Tool  on the Toolkit toolbar to display the Attribute Tool 
dialog box. 

2. Select the Practice Layer you wish to attribute. 

3. Once the Layer has been selected the Attribute Tool dialog window will display the 
appropriate dialog boxes to complete the attribute record. 

 

4. Use the Select Feature icon   to select one practice in the practice layer. 

5. Complete the attribute information for the selected field.  

• Tract number is optional. Select a tract from the drop-down list, enter one 
in or leave it blank. 

• Land Unit is required. Select a land unit from the drop-down list or enter a 
field number. Field numbers may be numbers, letters or a combination of 
both (e.g., 1, 1a, 1A). 
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• Code and Name are required. Select either a Practice Code or Practice 
Name from the drop-down lists. 

• Planned Amount defaults to the calculated amount. Accept the default or 
enter in a new amount.  

• Planned Month and Year are required. Enter in the planned month and year. 

• Applied Amount and Date are optional. Enter in the applied amount and date 
or leave them blank. 

6. Once the attribute information has been completed for the selected feature, click 
Apply. 

7. Click on the next feature to attribute. Continue the process of selecting practices, 
completing the attribute information and clicking Apply after each entry. 

8. When finished attributing all practices, click OK to exit the Attribute dialog box. 

• Practices that were attributed have been added to the practice schedule.   

9. Open the practice schedule to select practice narrative IDs for each record that 
was added to the practice schedule with the Attribute Tool  (see Edit Existing 
Practices in the Practice Schedule). 

 
Enter Data for Resource Inventory  

1. Click the Attribute icon  to display the Attribute Tool dialog box. 

2. Select the resources inventory layer you wish to attribute. 

• Once the Layer has been selected, the Attribute Tool dialog displays the 
appropriate dialog boxes to complete the attribute record. 

3. Use the Select Feature to select one resource inventory feature in the resource 
inventory layer. 

4. Complete the attribute information for the selected feature.  

5. Once the attribute information has been completed for the selected feature, click 
Apply. 

6. Click on the next feature to attribute. Continue the process of selecting features, 
completing the attribute information and clicking Apply after each entry. 

7. When finished attributing all features, click OK to exit the Attribute dialog box. 

 

Soils Map/Inventory 
Soils Map/Inventory Tool 

The Soils Map/Inventory tool  on the Toolkit toolbar works only when a soils theme and 
a land unit layer are added to the view.  You can use the Soils Map/Inventory tool to:  
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• Produce a customized soils map and legend for the customer. 

• View an inventory of soils for a specific field(s). 

Create a Soils Map 
1. To create a Soils Map layer for all the land units in the land units layer, clear any 

selected features in the land units layer.   

• You may use the Clear Selected Features icon  to clear a selection. 

2. Click the Soils Map icon . 

• The Soils Map and Inventory dialog box is displayed. 

3. To create a Soil Map theme for only a few land units in the land units theme, first 

select the land units from the theme with the ArcGIS Select Feature icon .  

4. Then click the Soils Map icon. 

 
5. Select Land Unit Layer from the from the Selected Layer drop-down list. 

6. Select Soils Layer from the drop-down list. 

7. Accept the Layer Name, Soils Map or enter another name.  

8. Accept the default file name or click the Browse to enter another file name.  

• Do not change the path of the new layer. 



Toolkit ArcGIS Extension   February 17, 2005 

53 

9. In the Soils Inventory Report Display options, check the check boxes for any items 
you want to include in the soils report, including the Customer Information.  

10. To summarize by Tract and Land Unit Numbers,check the check box.  

11. Click OK.  

• The Soils Map layer is added to the view at the top of the table of contents.   

• A soils report is displayed on top of the View window. 

12. You may print and/or save the soils report by clicking on the File menu.   

• Use the standard Windows Print/Save functionality. 

13. To close the soils report click on the X in the top right corner of the document.  

 

Buffering Tool 
Buffer Tool 
Use the Buffer tool to create areas around a point or line, or inside or outside a polygon.  

• Buffer Points 

• Buffer Lines 

• Buffer Polygons 

 
Buffer Points 
To buffer a point, complete the following steps. 

1. Use the Select Features icon  to select the feature(s) you wish to buffer. 

2. Click the Buffer icon .  

• The Buffer dialog box is displayed. 

3. Follow the Buffer Wizard instructions and make choices as necessary.  
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• The first dialog window allows you to select the graphics/features you wish to 

buffer.   

• You may buffer graphics in the view or the features of a layer.   

4. If you only want to buffer the selected graphics/features, check the box Use only 
the selected features/graphics.   

• If the box is unchecked, all features/graphics are included in the buffer 
layer.  

5. Click Next. 

• The next dialog window varies based on the type of layer you are working 
with.   

• If you are working with points, the following window is displayed.  
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6. Select the location to save the created buffers.   

• You may save them as a graphics layer, add them to an existing layer or 
create a new layer in the view.  

• Make your selection, and name the file if necessary.  

7. Click Finish. 

• The new buffer layer is added to the View. 

 
Buffer Lines 
There are three options available when buffering lines.   

• On both sides of the line(s) buffers both sides of the line with 1/2 the buffer on 
each side of the line, and the width of the buffer is the value entered in the 
Width/Distance box.  

• On the left side of the line(s) 

• On the right side of the line(s) 

To buffer, complete the following steps. 

1. Use the Select Features icon  to select the feature(s) you wish to buffer.  
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2. Click the Buffer icon . 

• The Buffer dialog box is displayed. 

3. Follow the Buffer Wizard instructions and make choices as necessary.  

 
• The first dialog window allows you to choose the graphics/features you wish to 

buffer.   

• You may buffer graphics in the view or the features of a layer.   

4. If you only want to buffer the selected graphics/features, check the box Use only 
the selected features/graphics.   

• If the box is unchecked, all features/graphics are included in the buffer 
layer.  

5. Click Next. 

• The next dialog window varies based on the type of layer you are working 
with.   

• If you are working with lines, the following window is displayed. 
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6. Select the type of buffer you want to create.   

• On both sides of the line(s)  

• On the left side of the line(s) 

• On the right side of the line(s) 

7. Select the location to save the created buffers.   

• You may save them as a graphics layer, add them to an existing layer or 
create a new layer in the view.  

• Make your selection, and name the file if necessary.  

8. Click Finish. 

• The new buffer layer is added to the view. 

 
Buffer Polygons 
To buffer a polygon, complete the following steps. 

1. Use the Select Features icon  to select the feature(s) you wish to buffer. 

2. Click the Buffer icon . 
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• The Buffer dialog is displayed. 

3. Follow the Buffer Wizard instructions and make choices as necessary.  

 
• The first dialog window allows lets you select the graphics/features you wish to 

buffer.   

• You may buffer graphics in the view or the features of a layer.   

4. If you only want to buffer the selected graphics/features, check the box Use only 
the selected features/graphics.   

• If the box is unchecked, all features/graphics are included in the buffer 
layer.  

5. Click Next. 

• The next dialog window varies based on the type of layer you are working 
with.   

• If you are working with polygons, the following window is displayed. 
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6. Select the type of buffer you want to create.   

• Inside and Outside the polygon(s) creates a buffer on both sides of the 
polygon (boundary).  If you chose a buffer width of 25 feet, the buffer is 
actually be 50 feet wide. 

• Only Outside the Polygons(s) creates a buffer around the selected 
polygon(s). 

• Only Inside the Polygons(s) creates a buffer inside the selected polygon(s). 

• Outside polygon(s) and include inside creates a buffer around the outside 
of the polygon and add it to the polygon area.    

7. Select the location to save the created buffers.   

• You may save them as a graphics layer, add them to an existing layer or 
create a new layer in the view.  

• Make your selection, and name the file if necessary.  

8. Click Finish. 

• The new buffer layer is added to the view. 
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Map Labels Tool 
Map Labels Tool 

Use the Map Labels tool  to label map features. Up to five attributes may be included in 
a label. The tool is available for all layers, other than images (ortho imagery, topographic 
maps).  

• Label a Map 

• Work with Annotation Layers 

 
Label a Map 

1. To label selected features on the theme, use the Select Features icon  to select 
one or more features.  

• To label every feature on a layer, be sure there are no selected features in 
the layer you wish to label.  

• You may use the Clear Selected Features icon  to clear a selection. 

2. Click the Map Labels tool  on the Toolkit toolbar. 

• The Map Labels dialog is displayed.  

3. Select the Layer you wish to label from the drop-down list. 
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4. By default an annotation layer is created for the labels. If you do not wish to create 
an annotation layer, uncheck the Create Annotation Layer check box.    

• Creating an annotation layer allows you to edit individual labels, and turn 
labels on and off (independent of the layer being displayed).   

• For more information on annotation layers see Work with Annotation Layers. 
   

5. For Label Style, accept the default style Text or click the drop-down list to select 
Bullet Leader or Callout from the list.  

Note:  If a unit that is needed is not displayed in the drop-down menu, you may enter it 
manually. 

• A sample of the selected style appears in the window. 

6. The Label Properties allows you to resize the text and select whether or not to 
scale the labels.   

• Click the Scale Labels check box to resize labels automatically when the 
view is zoomed in or out. 

7. Click the check boxes preceding the attribute fields to include up to five attributes 
in the label.  

8. Under Field, click the drop-down list to select the Field attribute for the first line 
of the label.  

9. Under Text, enter a word that you want to precede the attribute in the label.  

10. Select Units for number data fields (e.g., acres).  

• In the above example above the units for LU_ACRES are acres, and AC will 
be displayed on the label following the acreage. 

11. Under Decimals, click the drop-down list to select the number of decimal points (0-
4) to display.  

• In the above example acres are rounded to one decimal place (tenths). 

12. Repeat steps 8-11 for each of the attributes you wish to include in the labels.  

13. Once the labels have been set up, save the preferences for future use by selecting 
Save User Preferences.   

• At any point in the future, you may use the User Preference button to 
retrieve the preferences when creating labels for another layer.   

14. When you are finished setting up the labels, click OK.   

• If you chose to create an annotation layer, the following dialog window will 
be displayed. 
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15. Enter a name for the annotation layer in the box, click OK. 

• The labels are displayed on the map. 

• Some labels may need to be repositioned.  

 
Work with Annotation Layers 
If you created annotation layers when you created the labels, you are able to turn the 
annotation on/off at will. You may also edit individual labels or change the font size, style, 
color or the location of the label. To access the annotation layer, complete the following 
steps. 

1. Hold the cursor over the View, right-click and select Properties. 

• The Data Frame Properties dialog window is displayed  

• Under the Annotation Group tab, a list of available annotation layers is 
displayed. 

2. To turn the display on, check the annotation layer check box. 

• To turn the display off, uncheck the annotation layer check box. 

3. Click OK to close the dialog window. 

4. To edit the font size, style, or color of a label, use the Select icon from the 
Drawing toolbar located at the bottom of the ArcGIS interface. 

5. Once a label is highlighted (it will have a dashed box around it), use the Drawing 
toolbar to make your changes. 

 
6. To reposition a label, use the Select icon to select the label. Hold down the left 

mouse key and drag it to the desired location.  

7. To add more text to the label, double-click on the label with the Select icon, and 
then add the text as needed. 

 
Map Products  
Use the Map Products tool to create a map with a heading, legend, scale, and North arrow. 
This tool is always active. 
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General information that you type in the choice lists in the Map Products dialog box is saved 
in: C:\Documents and Settings\<login>\Local Settings\Application Data\USDA\Toolkit5. 
 The information saved includes Map Title, Agency, District, Field Office and Assisted By 
values,  The next time you open the Map Products tool, the previous settings are available in 
the choice lists on the dialog box. The values entered for Approximate Acres, Date and 
Legal Description are not saved.   

• Create a Map Product 

• Modify Layout Elements 

 
Create a Map Product 

1. Click the Map Products icon  to open the Map Products dialog box. 

• The View changes to a Layout View 

• The map is displayed behind the Map Products dialog window. 

 
• Add a check mark to each item you wish to include in the map header (e.g. 

Assisted By).  

• Text may be added to any dialog box/choice list by typing in a blank box. 

• To remove an item from a dialog box/choice list, highlight the item and press 
the Delete key. 

2. For Map Title, select a title from the drop-down list or enter a title in the dialog 
box.   

• The Customer name field is not editable. 

3. Select the Field Office from the drop-down list or enter in a field office name in 
the dialog box.  
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4. Select the Agency from the drop-down list or enter in the agency name in the dialog 
box.  

5. Select the Conservation District from the drop-down list or enter in the district 
name in the dialog box.  

6. To include a list of Land Units in the header, add a check mark to the Land Units 
check box. 

7. Select a name from the Assisted By choice list or enter a name  

8. To include a Date, enter a date in the date dialog box. 

9. To include Approximate Acres, enter an amount in the dialog box. 

10. To include a Legal Description, enter the description in the dialog box. 

11. Click Apply to refresh the header settings in the layout. 

12. Click on the Layout and Scale tab. 

 
13. For Size select a standard page size from the drop-down list.   

• The printer must support the selected format. 

14. For Scale select a standard scale from the drop-down list.   

• If you select user-defined scale, another dialog box is displayed. Enter the 
desired scale in the dialog box. 

15. Select a Logo from the drop-down list. 

16. To include a standard statement, click the Browse button, then navigate to the 
statement you wish to include on the map.  

• Standard statements are saved as text files and stored in the (C:\Program 
Files\USDA\Toolkit5\Templates\PlanWizard) directory. 

17. Click Apply.  
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18. To save a copy of the layout for future reference, click on the Save button.   

 

 
• Layouts are saved by default in the customer’s Resource_Maps folder. 

19. In the Name box, enter a filename for the layout. 

20. Click Save. 

21. Click OK on the Map Products dialog box to dismiss the window. 

Once the layout has been created, you can modify various elements of the layout using the 
Draw toolbar located at the bottom of the ArcGIS interface (see Modify Layout Elements). 

 
Modify Layout Elements 

1. To modify an element, use the Select icon to select the item you want to modify. 

2. To change the heading information from the Layout view, use the Select icon to 
double click on a text box. Modify the text in the Text Properties dialog box.  

3. To move the heading information, click on the text and then drag it to another 
location.  

4. To change the font size, style or color, select the piece of text with the Select 
icon. Then use the font tools on the drawing toolbar to make your changes. 

5. To change the north arrow or scale, use the Select icon to double-click on the 
element you wish to modify to open the corresponding properties dialog window. 
Make changes as needed, then click OK to dismiss the dialog window.  

6. You may remove an element (north arrow, scale bar, etc) by selecting it, then 
pressing the Delete key. 
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Use the Layout Zoom Tools 
1. To zoom in and out on the Layout, use the Zoom Toolbar located at the bottom of 

the ArcGIS interface. 

 
2. If the Toolbar is not displayed, click on the Tools menu and check the Layout option. 

Print the Layout 
1. ArcGIS uses the standard Windows print functionality. From the File menu, select 

Print. 

2. When you are finished working with the layout, you may return to the View window, 
by clicking on the View icon in the lower left corner of the Layout window. 

 

 
Save the Layout 

1. From the File menu, select Export Map. 

2. Save the layout to the customer’s Resource_Maps subfolder.  Name the layout, and 
choose the desired file type. 

3.  Click Save. 

 

CAUTION!  Toolkit 2004 does not automatically save layouts, as in earlier versions of 
Toolkit.  You must use the Export Map option to preserve the layout. 

 


